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SOFTWARE INSTALLATION

1. Using a laptop or desktop, download the Narva HUB programming tool
from: https://wadegroupltd.com/applications/narva_hub/setup.exe
NOTE: if you use a desktop you most likely won’t be able to configure the unit
when it’s installed into a vehicle.

2. Run the installer. You may be prompted from Microsoft Defender
SmartScreen. Click ‘Run anyway’.

Windows protected your PC

Application Install - Security Warning x
Publisher cannot be verified. (=]
Are you sure you want to install this application? @_f

Name:
Narva HUB Programming Tool

From (Hover over the string below to see the full domain):
www.bentech.co.nz

FPublisher:
Unknown Publisher

Install Don't Install

While applications from the Internet can be useful, they can potentially harm your computer.
If you do not trust the source, do not install this software. More Information...

3. Wait for the install process to complete.
(379%) Installing Narva HUB Programming Tool - X

Installing Narva HUB Programming Tool =

This may take several minutes. You can use your computer to do other tasks
during the installation.

@ Name: Narva HUB Programming Tool

From: www.bentech.co.nz

Dawrnloading: 722 KB of 1.89 MB

Cancel




RUN

1. Once the install is complete, it will run the application. The SmartScreen
may prompt you again, so once again click ‘More info’ and then ‘Run
anyway’.

2. When the application runs, it will check for the Wade EVCS USB driver. If it
is not found, it will prompt you to install it.

Wade EVCS Device Driver *

A Wade EVICS USE Serial Port device does nat appear to be installed,
Click OK, to continue with the driver installation,

NARVA HUB INSTRUCTIONAL INFORMATION

1. Once the install is complete, it will run the application. The SmartScreen
may prompt you again, so once again click ‘More info’ and then ‘Run
anyway’.

2. When the application runs, it will check for the Wade EVCS USB driver. If it
is not found, it will prompt you to install it.

USB Driver Install Complete = {7 *

The driver installation has completed. Please follow these steps:
Step 1:

Ensure the Narva HUB is powered and
connect it to the PC via an available USB
port.
hqﬁ/
Step 2:

Wait at least 10 seconds for the device
driver software to be setup.

Step 3:
Click OK to continue.

Connection: When a connection is established with the Narva HUB, the
status bar at the top will be green. If the USB has been connected and the
bar remains Red, click the Connect button as shown below.

act & button below fo edit it’s seltings.
Button 1 Seftings
Operaling Mode:  Disabled
Restores state after
Indicator LED: Disabled 1GN cycle



NARVA HUB PROGRAMMING TOOL

The Narva HUB is configured and diagnosed using the Narva HUB
Programming Tool as shown below. A single application is used for configuring
a Narva HUB system as well as performing remote diagnostics and delivering
device firmware updates.
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NARVA HUB PROGRAMMING TOOL

Button Settings

When connecting to a new Narva HUB, it will be configured with default
settings similar to the image below.

Buston 3 Seatngs
Operating Mode:  Toggle: 8 Remenber State
. indicator LED: | Sokd e
Click L ¢ Button
Button o Tome e Settings
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To configure a button, it must firstly be loaded with a button icon. Choose an
icon appropriate for the desired function and drag it from the icon library on
the right onto the desired button on the Narva HUB preview. Click the button
on the Narva HUB preview to display/edit the buttons settings.

NOTE: The icons are pre-loaded with default settings. Most settings can then
be changed unless they rely on built in functions. For example, a light bar
pattern.

Operating Mode
The operating modes consist of:

e Disabled — The button does not function. When selected, the icon is
removed.

e Momentary — The desired output or function is active while the button is
pressed and held.

e Toggle — The desired output or function is turned on/off on each press of
the button.

e Front — The secondary lights pattern consisting of the forward facing lights
only. This applies to both the SLC and the Light Bar if installed.

e Rear - The secondary lights pattern consisting of the rear facing lights
only. This applies to both the SLC and the Light Bar if installed.
Indicator LED

The indicator LED on each RCH button can be set as one of the following
options:

Setting Description

Disabled The LED will not illuminate

Solid The LED will be illuminated when the button function is active
Flashing Slow The LED will flash slow when the button function is active
Flashing Fast The LED will flash fast when the button function is active




NARVA HUB PROGRAMMING TOOL

Output Channel

The button can be configured to turn on any available channel. The channels
available are subject to the modules installed and the selections made in
General Settings. For example, turning on Disable Grill Lights makes the

grill light channels available to the button settings. See the Output Channels
section for more details.

HINT: Once the Narva HUB configuration has been set up, the device pin outs are
available via the View -> Pinouts menu. The pinouts can then be printed for ease of
installation — See below default settings and pin out view example

A —— B -
EREE
" 78| 9jhoj1j2 34
SLC Plns Wew from WIRE SIDE of plug E .
Pin Description Function Input Pullup Max Current
A1 Hom Out / In 0.5A
A2
A3
A4
A5 Speaker - Analogue
A6 Speaker + Analogue
A7 Front Left Out Lights 6A
A8 Front Right Out Lights 6A
A9 Grille Left Out Lights 6A
A-10  |Grile Right Out Lights 6A
Al Rear Left Out Lights 6A
A-12  |Rear Right Out Lights 6A
B-1
B-2
B3
B4
Oose
Siren Tone

The siren tone for each button can be set to one of the built in software
generated tones. If no siren tone is required, select None.

Remember State

When set, the state of the button prior to the system being turned off (IGN and
IGN Bypass turned off) is restored when the system is turned back on. The
button state includes any output and siren tone that may be set. This feature
can be useful when an output is being used to enable equipment power such
as a radio.

NOTE: Remember State can only be set for buttons that have the Toggle operating
mode.



GENERAL SETTINGS

Light Bar Installed — Possible Optional lightbar controller
Enable when the LBC is installed in the system.
Automatic Light Bar Dimming

Enables dimming of the light pattern brightness based on the light sensor
in the Federal Signal Integrity light bar.

I/0 Module Installed
Enable when the Wade I/0 Module is installed in the system.
Operating Mode
Select the mode of operation for the 1/0 Module as follows.
e |0 Module — General Input/Output module.
e Pursuit Light Bar — Operates a Code 3 Pursuit light bar.
e Defender Light Bar — Operates a Code 3 Defender light bar.

Bonnet Ajar

When enabled, the siren volume reduces while a signal is applied to the SLC
A-4 input. This feature is useful to prevent extreme noise during unwanted
siren activation while a technician is working in proximity to the siren speaker.

NOTE: The input changes to A-3 if the IGN Signal Input Enabled feature is enabled.

IGN Signal Input Enabled

Enables input A-4 on the SLC as an ignition signal input. The ignition signal is
used to turn the Narva HUB system on and off and if not used an IGN Bypass
button must be configured for the system to operate.

Output

An optional IGN signal output can be selected which will turn on when the
ignition...

SLC Lights/Siren Active Out

When enabled, the chosen output will be active while any light or siren function
is active.

Primary Lights Only

Enable to prevent the output when only the secondary lights pattern is
active.

Front/Rear 2-Channel Lights
Has the same effect on the grill light channels as Disable Grill Lights above.

NOTE: See outputs section for more details on this setting.



GENERAL SETTINGS

Disable Grill Lights
Disable the grill light feature and free the channels for button selection.

NOTE: See outputs section for more details on this setting

IGN Controlled Girill Lights

Disables the grill lights when the IGN signal is OFF. This feature is useful when
grill lights must be disabled if the vehicle is parked on the side of a road.

Steady On LED Outputs

Changes all channels being used by the light patterns to steady on, effectively
disabling all light patterns. This feature is useful when self patterned lights are
required.

Steady On Grill Lights

Changes the grill light operation to steady on, where the channels turn on while
activated and do not follow the light patten.

Quad Flash LEDs Only

Forces the secondary light pattern to be quad flash, the same as the primary
light pattern. See Light Patterns for more details.

Disable Lights Active Beep

Disables the periodic beep that the Narva HUB emits while a light pattern is
active.

Input Pull Up

All inputs consist of a ‘pull down’ style circuit, designed for positive signals.
Configurable 10KQ pull up resistors are available on the displayed inputs to
support negative input signals. If the connected signal is negative (switched to
ground) then the corresponding Pull Up must be enabled in order for the signal
to be detected.

Input Polarity
The polarity of the displayed inputs can be set to detect either a positive or
negative signal.

NOTE: A Negative input polarity requires that the corresponding Input Pull Up be
enabled.
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INPUTS

Several inputs are available on the SLC as follows:
Horn

SLC channel A-1 can be wired to a vehicles negative horn signal to activate
the SLC horn siren tone. When a horn button is configured, this output will also
be driven to activate the vehicles horn and electronic siren horn.

HINT: When a horn is not required, leave this pin disconnected.

IGN Signal

SLC channel A-4 can be wired to the vehicles ignition signal to enable the
Narva HUB system when the ignition is turned on.

HINT: The ignition signal is typically driven positive; however, a negative signal can be
supported by changing the Input Polarity to Negative and enabling the Input Pull Up.

Bonnet Ajar

An optional bonnet ajar input can be wired to the vehicles bonnet open switch
to reduce the siren volume. A typical bonnet ajar circuit is switched to ground
(negative signal) so when enabled, the corresponding Input Polarity and Input
Pull Up will automatically be configured as necessary. Any change will trigger
a message highlight as shown below. The change can be reverted to the
previous state by clicking on the blue link in the message.

LIRS F WOaw DLW LEF o7

B sLc A4 -'P':’-i'i'c‘ '1. g;'.‘a.-‘::

SLC A-3: © Postive () Negative

The SLC input for the bonnet ajar defaults to A-4, but changes to A-3 if the
IGN Signal Input is enabled.



OUTPUTS

The channels available for button settings depend on the modules that are

installed and the settings in the General Settings section.

Device Channel Function Alternative Function
SLC A-1 Horn General Output
SLC A-2 General Output

SLC A-3 General Output Bonnet Ajar Input
SLC A-7 Lights (Front Left)

SLC A-8 Lights (Front Right)

SLC A-9 Lights (Grill Left) General Output
SLC A-10 Lights (Grill Right) | General Output
SLC A-11 Lights (Rear Left) General Output
SLC A-12 Lights (Rear Right) | General Output
SLC B-1 General Output*®

SLC B-2 General Output*®

SLC B-3 General Output*®

SLC B-4 General Output*

LBC Takedown Light Enable

LBC Left Alley Light Enable

LBC Right Alley Light Enable

IOM A-3 General Output

IOM A-4 General Output Dim

IOM A-5 General Output Left Alley

IOM A-6 General Output Rear Lights
IOM A-7 General Output*®

IOM A-8 General Output*®

IOM A-11 General Output

IOM A-12 General Output Right Alley
IOM A-13 General Output Takedown

IOM A-14 General Output Front Light
IOM A-15 General Output*

IOM A-16 General Output”

*These channels are high power channels suitable for driving lights. Consult the
technical specifications of the relevant device for further details.

11
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OUTPUTS

Grill Lights

The grill lights form part of the light patterns where the left grill light follows the
front right light and the right grill light follows the front left light.

NOTE: Several settings affect the operation of the Grill light channels as detailed in
General Settings.

Light Channels

The following table shows what channels are available for buttons based on
the Front/Rear 2 Channel Lights and Disable Grill Lights settings:

Front/Rear 2 Disable Front | Front | Rear | Rear | Grill | Grill
Channel Lights | Grill Lights | Left | Right | Left [Right |Left |Right

OFF OFF NO NO NO NO NO NO

OFF ON NO NO NO NO YES | YES

ON - NO NO YES |YES |YES |YES
Pinouts

Pinout tables for relevant connected devices can be viewed from the View ->
Pinouts menu. The pinouts are dynamically generated based on the current
configuration and can be printed for ease of installation.

CONFIGURATION PROGRAMMING

To program the configuration into the Narva HUB, simple click the Set Config
button at the bottom right.

4 GetCortic PSS

The Set Config button will highlight green when changes have been made in
the tool that have not been sent to the Narva HUB. If the Get Config button is
clicked, a prompt will ask to confirm the upload from the Narva HUB as it will
overwrite any unsaved changes.

Transfer Configuration
To transfer the configuration from one Narva HUB to another, do the following:

1. Connect the first Narva HUB and download the configuration by clicking
Get Config.

2. Optionally save the configuration (see Save/Load Setup) to use later.
3. Disconnect the first Narva HUB and connect the second one.
4. Click Set Config to program the configuration.



OTHER SOFTWARE FEATURES

Save/Load Setup

The Narva HUB configuration can be saved to a file and loaded at a later time.
This is particularly useful when you want to load a common configuration to
multiple Narva HUB installations.

Login

Authorised service personnel can login to retrieve special firmware updates
and perform remote diagnostics. Please contact your local Narva HUB sales
representative for more information.

Clear Log

This menu option clears the Narva HUB system log stored in the device. It can
be helpful to clear the log for clarity during diagnostics.

Diagnostics Report

If you are requested to submit a diagnostics report by a support technician,
you can do this via the Diagnostics > Submit Report menu item. This collects
information about the connected Narva HUB system and submits it to the
cloud to be analysed by the technician. Information that is submitted includes:

e Details provided by the user in the Submit Report dialogue
e Details of the connected devices

e Narva HUB configuration

e Narva HUB system logs

e Current system status

Diagnostics Mode

Diagnostics mode enables the recording of additional events and information
in the system log and should only be enabled when requested by a support
technician. The mode automatically disables after a timeout
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FIRMWARE UPDATES

Updates are downloaded periodically in the background and are available to
download into each unit via the device details panels on the left hand side as
shown below. You can also check for updates at any time via the Help menu.

Hardwars Version: 1.0 e
Femweare Version: 1.0.4
Hardware Version: 2.2 wee
Frrmware Version: 1555

Update v1 54 8

Hardhware Version 14 -
Frmware Version: 3.16.3

Updating Firmware

To update the firmware of a connected device, simply click the Update button
in the corresponding device panel. The status of the update process is shown
in the status bar at the bottom of the application.

Narva HUB

Te Narva HUB will perform a restart during the update process, at which time it
will disconnect from the PC. It will automatically reconnect once complete. If it
does not, please cycle power and reconnect manually.

All Other Devices

Firmware updates of all other devices involves the file being downloaded to
the Narva HUB first, and then updated over the corresponding communication
data cable. Do NOT disconnect the device or turn off the power during a
firmware update.

NOTE: Additional firmware updates cannot be performed until the current process has
completed.



OPERATION

Buttons

Apply the corresponding button stickers that match what is set in the
configuration. Once configured the buttons should operate according to the
configuration.

Rotary Switch

The rotary switch on the Narva HUB has 6 positions that function according to
the table below.

Position Lights Mode [ Siren Mode

OFF None None

L1 Secondary None See Light Patterns for details

L2 Secondary None See Light Patterns for details

S Primary Siren 1 See Siren Tones for details

S2 Primary Siren 2 See Siren Tones for details

S3 Primary Siren 3 See Siren Tones for details
SIREN TONES

The SLC comes with 8 built in siren tones that can be chosen for each of the
three siren positions (S1, S2 and S3). The siren tones are selected in the Siren
Tones section as shown below.

Saen Tones
Siren 1- Wail . Sien 2 Wal

Suen 3 HiLo

NOTE: Siren tones are software generated and custom tones are available on request.

LIGHT PATTERNS

Two light patterns are built into the SLC and LBC called Secondary and
Primary. They are standard light patterns used for emergency vehicles and
custom light patterns can be added on request. The timing of the patterns is
detailed in the following table:

Pattern Flashes Per Side Flash Time (On + Off) [ Cycle Time
Secondary |1 380ms + 380ms 760ms
Primary 4 45ms + 45ms 720ms

The light patterns are activated either by selecting a position on the rotary
switch, or by activating a button that has a Front or Rear Operating Mode
assigned to it (via a compatible button icon). If enabled, the Narva HUB emits a
periodic beep while a light pattern is active.



WARRANTY

MANUFACTURER’S PRODUCT WARRANTY
Applicable only to product sold in New Zealand

In addition to the rights that you may have as a consumer under the New
Zealand Consumer Guarantees Act 1993, Brown and Watson International NZ
Ltd (BWI N2Z) provides a LIMITED REPLACEMENT GUARANTEE for BWI NZ
products bought new in New Zealand that expires 3 YEARS from the date of
original purchase.

Brown and Watson International NZ Ltd (6081127) of 19 Bell Avenue, Mount
Wellington, Auckland 1060, telephone: 09 5254575, warrants that all products
described in this manual will be free of failures in material and workmanship for
a period of three (3) years from the date of the original purchase as new by the
consumer, as marked on the invoice. This warranty is conditional upon the
products having been used only for the intended purpose and in accordance
with the instructions and on the products having been maintained and serviced
in accordance with the instructions.

This warranty does not cover:

e Failures resulting from abuse or damage which was not caused by defective
material or workmanship,

¢ Usual wear and tear,
¢ Products which have been modified or altered after purchase,

e Consequential damage claims will not be covered by this replacement
guarantee.

To make a warranty claim the consumer should deliver the product to the
original place of purchase with evidence of original purchase (such as an
invoice) or to any other place which may be nominated by either BWI NZ so
that a warranty assessment may be performed. BWI NZ will reimburse you for
your reasonable delivery (freight) costs if it approves your claim. The consumer
must also deliver an explanation in writing as to the nature of the claim. In

the event that the claim is determined to be for a minor failure of the product
then BWI NZ reserves the right to repair or replace it at its discretion. This
replacement and restoration will be provided on a without prejudice basis, and
without any admission of liability.

IMPORTANT NOTE: Our goods come with guarantees that cannot be
excluded under the New Zealand Consumer Guarantees Act 1993. The
benefits given to you by this Manufacturer’s Product Warranty are in
addition to the rights you may have as a consumer under the Consumer
Guarantees Act 1993.
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